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Emulation 

T27 eXpress IT Control Panel 

The T27 eXpress IT Control Panel initially appears when the T27 eXpress IT program is executed 
from the T27 eXpress IT folder.  The control panel contains a series of functions that permit you to 
establish emulation sessions with the host and control the disposition of the control panel.  Additionally, 
a configuration command is available allowing font and color selection, configurable T27 keys, screen 
size selection, route selection and other standard T27 controls. 

 

  
 

Left Mouse Click 

A left mouse click on the following button controls allows you to establish host connections, to 
configure T27 eXpress IT, etc.: 

 Environment Buttons 

Press any of the numbered buttons to open a dialog with the host. 

The maximum number of environments that may be configured is two 

 Minimize All 

Press this button to minimize the T27 eXpress IT Control Panel and all active T27 eXpress IT 
windows. 

 Configure 

Press this button to initiate the T27 eXpress IT Configuration dialog where the appearance 
and behavior of T27 eXpress IT may be changed. 

 Help 

Press this button to receiv  help for the T27 eXpress IT Control Panel. 

 Exit 

Press this button to close all environments currently opened and terminate T27 eXpress IT. 

Right Mouse Click 

A right mouse click anywhere within the control panel will present a menu that allows you to control 
sessions, to position the button bar, etc.: 

Open Screens 

Move the mouse cursor over this selection to view a menu of configured screens.  Only the 
screens not currently opened will be enabled for selection. 

Close Screens 

Move the mouse cursor over this selection to view a menu of configured screens.  Only the 
screens currently opened will be enabled for selection. 

Close All 

Left mouse click this selection to close all screens currently opened and terminate T27 eXpress 
IT. 
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Minimize Application 

Left mouse click this selection to minimize the T27 eXpress IT Control Panel and all active 
screens. 

Keep on Top 

Use this selection as a toggle.  Keep on Top will force the Control Panel to be displayed on top 
of all other windows.  If this selection is not checked, the Control Panel may be hidden from 
view by selecting/moving another window over it. 

Auto Hide 

When the control panel is docked to an edge of the desktop, selecting this option will cause the 
control panel to hide when the mouse cursor is away from the edge. 

Note: To dock the control panel, drag and drop the control panel with the mouse to any edge 
(left, right, top or bottom) of the desktop display. 

Transport Trace 

Use this selection to create a diagnostic trace at the transport level.  This selection should only 
be used if requested by KMSYS Worldwide’s support personnel. 

ETEM Trace 

Use this selection to create a diagnostic trace at the ETEM level.  This selection should only be 
used if requested by KMSYS Worldwide’s support personnel. 

 

T27 eXpress IT Screen 

A T27 eXpress IT Screen window contains all the necessary Windows controls to manage a host 
connection.  Controls are available to control the size of the font displayed and the spacing between 
lines.  There are also controls to perform print functions, recall previously entered input, execute user-
developed scripts, etc. 

When multiple screens are open, you may use the Esc key to switch between non-minimized screens.  
Likewise, the Next Window selection from the Window menu will switch between non-minimized 
screens. 

The following is an explanation of each menu selection or control.  When shortcut keys are available, 
the key combination (e.g., Ctrl+P) is shown to the right of the menu selection. 

File menu 

The File menu contains controls to configure the appearance and behavior of T27 eXpress IT and to 
manage the print environment of T27 eXpress IT. 

Print Screen (text only) 

Use this selection to print only the text portion of the screen without delimiters. 

Note: For passthrough printing, run the T27 eXpress IT Passthrough Print Manager program. 

Print Screen (with delimiters)   Ctrl+P 

Use this selection to print an exact image of the entire screen, including delimiters. 

Print Unprotected 

Use this selection to print only the unprotected text on the screen. 

Print Capture 

Use this toggle in conjunction with the Print commands to capture screen images and save 
them to a text file.  When this selection is checked, the Select Print Text File dialog appears 
allowing you to select a text file in which to save the images.  Next, use one of the Print 
commands to write the screen image to the file.  Multiple screens may be saved by using 
multiple Print commands.  To close the text file, select Print Capture again. 

Print Window Image 

Use this selection to print the entire window including the screen and the Windows controls 
surrounding the screen. 

Printer Setup... 

Use this selection to select a printer for use in future print operations. 
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Capture Screen 

Use this selection to capture the currently selected screen. 

Print Captured Screens... 

Use this selection to print any captured screens. 

Save Captured Screens... 

Use this selection to save any captured screens to a text file. 

Clear Captured Screens 

Use this selection to clear the captured screen stack. 

Send To… 

Use this button to send a copy of the screen through your mail system. 

Diagnostics 

Trace to Window 

Use this selection to initiate the T27 eXpress IT trace facility.  All communications 
between T27 eXpress IT and the host will be displayed in a separate window. 

Note:  A right mouse click in the trace window will reveal a menu containing three 
selections that control the trace window: Stay on Top, Copy to Clipboard and Clear.  
Stay on Top controls whether the trace window remains on top (the default) of the 
emulator window during the trace, or remains in the background.  Copy to Clipboard 
may be used to copy the contents of the trace window to the Windows clipboard for 
subsequent pasting into another Windows application (e.g., Notepad, WordPad, etc.).  
Clear may be used to clear the contents of the trace window. 

Trace to File 

Use this selection to initiate the T27 eXpress IT trace facility.  This selection is the 
same as Trace to Window except that the trace information will be written to a user-
named file. 

Trace to Both Window and File 

Use this selection to initiate the T27 eXpress IT trace facility.  This selection is a 
combination of the two above. 

Clear Trace Window 

Use this selection to clear the trace window and/or file without terminating the trace.  
This selection appears after a trace has been initiated. 

Close Trace 

Use this selection to close the trace window and/or file and terminate the trace. 

FCC Map 

Use this selection to display an FCC Map.  Use only at the request of KMSYS 
Worldwide’s support personnel. 

Note:  The previous three selections only become visible once the trace has been started. 

Customize 

Use this selection to customize the appearance and functionality of this screen.  Note: All of 
these settings may also be changed from the configuration program. 

Custom Keyboard Layout 

Use this selection to modify a keyboard configuration.  The initial configuration shown 
will be for the keyboard assigned to this screen. 

Select Keyboard Layout 

Use this selection to assign a preconfigured keyboard to this screen. 

Screen Appearance 

Use this selection to modify a screen appearance scheme.  The initial configuration 
shown will be for the scheme assigned to this screen. 
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Select Screen Appearance 

Use this selection to assign a preconfigured screen appearance to this screen. 

Close 

Use this selection to break the host connection and terminate this T27 eXpress IT window. 

Edit menu 

The Edit menu contains controls to manage selected text between the screen and the Windows 
clipboard. 

Copy   Ctrl+C 

Use this selection to copy selected data onto the clipboard.  This command is unavailable if there 
is no data currently selected.  Note: Copying data to the clipboard replaces the contents 
previously stored there. 

Data may be selected by placing the mouse cursor at some point on the screen, and holding 
down the left mouse button, drag the mouse cursor to any other location on the screen.  Upon 
releasing the left mouse button, the data will be selected. 

An alternate form of selection is with standard, keyboard key sequences.  With the mouse or 
arrow keys, place the screen text cursor at some point on the screen and use any of the 
following key sequences to highlight the data being selected: 

Shift+Home selects everything from the cursor position through column one of the 
same row. 

Shift+End selects everything from the cursor position through the last column of the 
same row. 

Shift+Right Arrow extends/contracts the selection to the right. 

Shift+Down Arrow extends/contracts the selection down the screen. 

Shift+Left Arrow extends/contracts the selection to the left. 

Shift+UP Arrow extends/contracts the selection up the screen. 

Cut   Ctrl+X 

Use this selection to remove the currently selected data from the document and put it on the 
clipboard.  This command is unavailable if there is no data currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 

Paste   Ctrl+V 

Use this selection to insert a copy of the clipboard contents at the insertion point.  This 
command is unavailable if the clipboard is empty. 

Note:  Use a right mouse click anywhere on the screen to reveal a Copy/Cut/Paste popup menu. 

Input Recall   Ctrl+I 

Use this selection to initiate the Input Recall window.  This selection allows previous lines 
transmitted to the host to be recalled and retransmitted. 

Rectangle Block Selection 

This option allows the selection of text as a rectangle.  When the left mouse button is held down 
and the mouse cursor dragged diagonally across the screen, a rectangular block of text is 
selected. 

Linear Block Selection 

This option allows the selection of text as a block of lines.  When the left mouse cursor is held 
down and the mouse cursor is dragged up or down, each line that the mouse cursor passes 
through will be selected. 

View menu 

The View menu contains controls that adjust the appearance and functional state of T27 eXpress IT. 

Show Keyboard Help Window...   Alt+K 

Use this selection to display the T27 eXpress IT Keyboard Definition window. 
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Show Mouse Tracking 

Use this selection to toggle between displaying the mouse pointer's row and column and the 
text cursor's row and column.  The display appears on the left side of the status bar at the 
bottom of the screen.  This feature allows the user to determine row and column coordinates of 
protected fields, which can be handy for script writers. 

Show Reference Grid 

Use this selection to toggle the display of a reference grid over the screen.  The grid is useful 
when developing scripts.  The reference grid makes it easy to find column/row coordinates 
while a script dialog is displayed.  You cannot use mouse tracking once a script dialog is up, but 
you can see and count lines and columns on the reference grid. 

Show Control Characters 

Use this selection to toggle the display of control characters (Tab, Form-Feed, Line-Feed, etc.). 

Macros menu 

The Macros menu is used to control the key macro recorder and to provide access to macros placed 
for selection on the menu. 

Macros 

Use this selection to drop down a list of user-created key macros. 

Use the Macro Manager selection (see the Other Settings tab after clicking the Configure 
T27 eXpress IT button on the T27 eXpress IT Control Panel) to develop and maintain 
macros and the Macros menu. 

Start Macro Recorder 

Use this selection to begin the Key Macro Recording (Note: A recorder icon will appear in the 
status line at the bottom of the window signifying that the recorder is active).  All keystrokes 
entered will be collected until the recording is terminated with the Stop Macro Recorder 
selection. 

Stop Recorder 

Use this selection to terminate the macro recorder.  Upon making this selection, the Save Key 
Macro dialog will allow the macro to be named and saved. 

Window menu 

The Window menu contains a selection controlling the T27 eXpress IT window size in relationship to 
the font size. 

Resize Window to Font 

Use this selection to resize the T27 eXpress IT window to conform to the selected font size. 

Hide Control Panel/Show Control Panel 

This toggle hides or displays the T27 eXpress IT Control Panel.  Note: If all screens are closed 
while the Control Panel is hidden, the Control Panel will be automatically displayed.  This menu 
item is disabled if the NCP (No Control Panel) command line parameter is used. 

Next Window   Crtl+Page Down 

Use this selection to switch between non-minimized screens. 

Help menu 

The Help menu contains selections that provide complete on-line help and T27 keyboard assistance. 

Contents 

Use this selection to run Windows Help for T27 eXpress IT and display the Contents topic.  All 
on-line help may be reached from this topic. 

This Window 

Use this selection to run Windows Help for T27 eXpress IT and display this topic. 

About 

Use this selection to display version and copyright  about T27 eXpress IT.  
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Input Recall window 

T27 eXpress IT, when in non-forms mode, saves single-line messages sent to the host system when 
you press the transmit key.  A maximum of 200 of the most recent messages is saved.  You can 
display a list of these messages from the Edit, Input Recall menu selection, or by pressing the Input 
Recall key (Ctrl+I). 

Paste 

When this list is displayed in the Input Recall window, you can view the entries and optionally 
select an entry to be "pasted" onto the current screen when the Paste button is pressed. 

Transmit 

The Transmit button performs the same operation as the Paste button, but also ends by 
transmitting to the host (double clicking on the entry also performs the paste-and-transmit 
operation). 

Close  

Use this button to close the Input Recall window. 

 T27 eXpress IT Keyboard Definition window 

This window displays all the standard T27 keys and their corresponding keyboard keystrokes.  Any T27 
key may be issued by double-clicking the left mouse button over the T27 key name. Additionally, the 
window may remain open as a visual reference when entering T27 key sequences from the keyboard. 

Stay on Top 

Check this box to force the window to remain visible while working on an emulator screen. 

Keep Active on Show 

Check this box to keep focus on the T27 eXpress IT Keyboard Definition window when the 
window first comes up.  When not checked, focus will immediately return to the main emulator 
window. 

Close 

Use this button to close the T27 eXpress IT Keyboard Definition window. 

Send To ... 

Use this dialog to select the Send option desired. 

Send Contents of Screen as Text 

Set this option to capture the contents of the screen as text.  When the OK button is pressed, the text 
will appear in the message portion of the compose dialog displayed by your mail system. 

Send Screen Window as JPEG Attachment 

Set this option to capture the contents of the screen as a JPEG image.  When the OK button is pressed, 
the image will be inserted as an attachment to your mail message. 
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Configuration 

T27 eXpress IT Configuration 

The T27 eXpress IT Configuration dialog contains configuration options that assign the 
communication route to be used when the screen is opened.  The dialog is also used to set T27 general 
options for the screen.  Each screen may also have its own keyboard layout and appearance scheme 
assigned.   

Environment tabs 

Select the environment tab you wish to configure.   

 

  

Connection tab 

This tab contains controls that may be used to assign a configured route to an environment. 

Select Connection Route 

This drop-down list box contains the names of all configured routes.  To assign a route to an 
environment, select one from this list.  Once a route is assigned, its corresponding numbered 
button will be enabled on the T27 eXpress Plus Control Panel . 

Configure 

Click this button to configure the routes and virtual destinations required to connect to a host 
(Note: Each screen in use should have its own configured route).  When complete, use the 
Select Connection Route drop-down list box to link a newly configured route to the selected 
screen. 

Open This Environment on Start 

Check this box to automatically connect to the route when T27 eXpress Plus is first started. 
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Trace on Start Options 

The controls in this group determine what trace activity is to take place, if any, when the screen 
is first opened. 

None 

When this option is set, no tracing activity will take place. 

To Window 

When this option is chosen, a separate trace window will open to display the trace. 

To File 

This option will cause the Emulator TraceFile dialog to open when the screen is 
opened.  In this dialog, enter the text file name for the trace file.  The trace file is 
normally stored in C:\Documents and Settings\<username>\Local Settings\Temp 
directory and will have a .txt extension.. 

To Both 

Select this option to trace to a window and file. 

 

 

Video Options tab 

The options on this tab govern the state of the monitor display.  Multiple options may be selected. 

Blinking Cursor 

Checking this box causes the current cursor position to blink.  If this box is not ch the cursor 
remains solid. 

Real Blink 

Check this box to cause data fields having the blinking attribute to blink on and off. 

If the Real Blink option is not used, blinking text will appear in the colors as configured for the 
Blinking option.  The Blinking may be set on the Color/Font Schemes tab of the T27 eXpress 
Plus Configuration dialog. 
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Visible Delimiters 

Check this box to display field delimiters when in forms mode (see Toggle Forms, below). 

Auto-save Pages 

When this box is checked, the contents of all pages in an environment are saved to disk when 
the environment is closed.  The pages are then restored when the environment is re-opened.  
Note: As a result of this action, page one will be overwritten on start up. 

 

  

DataComm Options tab 

The options on this tab govern communications between the host and PC.  Multiple options may be 
selected. 

Transmit Full Page in Forms Mode 

Check this box to cause the full page to be transmitted to the host when in forms mode (see 
Toggle Forms, below).  If this box is not checked, only the unprotected data from the home 
position to the cursor will be transmitted. 

Convert CR to CRLF 

Check this box to cause a line feed character to be appended to any carriage return character 
sent by the host application. 

Convert LF to LFCR 

Check this box to cause a carriage return character to be appended to any line feed character 
sent by the host application. 

SOH Clears Screen 

Check this box to cause the screen to be cleared upon receipt of an SOH character. 
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SOH Clears Forms Mode 

Check this box to cause forms mode to be terminated upon receipt of an SOH character. 

Position to Left of UPF 

When this option is checked, the effect of the Home function places the text cursor to the first 
character position of a right justified, unprotected field; otherwise, the cursor will be moved to 
the data entry position, or rightmost position of the field. 

Start All Pages in Forms Mode 

Check this box to set all pages initially to Forms mode.  See also, Transmit Full Page in 
Forms Mode, above, and Toggle Forms, below. 

Transmit Line at a Time 

Check this box to force the normal Transmit to act like the Transmit Line key. 

Hold in RCV Mode 

Check this box to cause the screens to remain in receive mode after getting a message from 
the host application (see Stay in RCV, below). 

Beep Alarm Sound 

Checking this box turns audible beep on.  If this box is not checked, no audible sound will be 
heard. 

SO/SI Translation 

Check this box to enable SO/SI (7-bit to 8-bit/8-bit to 7-bit) character translation on data 
transmitted to the host. 

SO/SI Extended Characters 

Check this box to enable SO/SI (7-bit-to-8-bit/8-bit-to-7-bit) character translation on data 
received from the host.  This option is not required if the host transmission is prefixed by ESC 
SO sequences. 

DC1 Function 

The mutually exclusively options in this group instruct T27 eXpress Plus how to interpret the 
DC1 character when received from the host. 

Stay in RCV 

Choose this option to keep the screens in receive mode upon receipt of a DC1 
character.  This option nullifies the Hold in RCV option (see above). 

Line Clear 

Chose this option to clear the line upon receipt of the DC1 character. 

DC2 Function 

The option buttons in this group instruct T27 eXpress Plus how to interpret the DC2 character 
when received from the host. 

Toggle Forms 

Choose this option to toggle to/from forms mode upon receipt of the DC2 character. 

Advance Page 

Choose this option to stay in the current mode (forms or no-forms) and advance the 
DataComm pointer one position to the right upon receipt of the DC2 character. 

Alternate Delimiters 

In this group, enter the alternate delimiters sent by the host application.  Use of alternate 
delimiters only applies when in forms mode. 

Left Character (hex) 

In this text box, enter the hex character sent and interpreted as the beginning 
delimiter of left-justified unprotected fields.  The default is the US character (1F). 

Right Character (hex) 

In this text box, enter the hex character sent and interpreted as the ending field 
delimiter.  The default is the RS character (1E). 
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Keyboard Options tab 

The options on this tab govern keyboard actions.  Multiple options may be selected. 

Start in UPPERCASE Mode 

Check this box to convert lowercase characters that are typed to their uppercase equivalents 
when the environment if first opened.  This option may be overridden with the 
Shift+<alphakey>, Ctrl+U (upper only off) and Shift+Ctrl+U (upper only on). 

Force UPPERCASE Only 

Check this box to convert lowercase characters that are typed to their uppercase equivalents.  
This option may not be overridden by keystrokes or the host program. 

Add LF to Return 

Check this box to cause a line feed character to be appended when the Carriage Return key 
(Enter) is issued.  If this box is not checked, only the carriage return is issued. 

Automatic Field Advance 

Check this box to advance the cursor automatically to the next field when the current field 
becomes full. 

Right Justified is Numeric-Only 

If this box is checked, only the characters 0-9, space, period (.) and comma (,) will be allowed 
in a right-justified field.  If the box is not checked, any character will be accepted. 

Insert Space in Insert Mode 

Check this box to cause a space to be inserted whenever the Insert key is struck. 
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Specify Sends Page Number 

Check this box to cause the page number (in addition to the normal column and row 
designating the cursor position) to be sent the host application when the Specify key is pressed. 

Specify Sends Hex 

Check the box to cause the cursor position (column and row) to be sent in hexadecimal when 
the Specify key is pressed.  When this box is not checked, the cursor position is reported in 
ASCII. 

Destructive Backspace Key 

Check this box to erase characters as the Backspace key is struck. 

Ignore Programmed Macros 

When checked, this box will cause the emulator to ignore any host or 
manually programmed T27 macro keys.  Checking this box does not prevent 
Enable scripts related to action keys from running.  The box is checked by 
default. 

CR acts like TAB 

Check this box to make the Carriage Return key (Enter ) behave like the Tab key. 

Tab Stops 

In this text box, enter the column positions (separated by commas) of the tab stops.  The 
default is 1,9,17,25,33,41,49,57. 

Character Translation Table 

From this drop-down list box, select a country that most closely matches your keyboard 
requirements. 

Clear Function 

The mutually exclusively option in this group specifies what action occurs when the Clear key is 
pressed. 

Clear Entire Screen 

Select this option to clear the entire screen. 

Clear Fields Only 

Select this option to clear all unprotected fields. 
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Other Settings tab 

The controls on this tab may be used to customize the screen's appearance (color, font, scaling, etc.) 
and configure keys and assign keyboards. 

Select Screen Appearance Scheme 

From this list, select a previously configured (see Custom Appearance, below) appearance 
scheme to be applied to this screen.  Note: This selection only affects the appearance of the 
screen portion of the screen window.  To alter the appearance of the entire T27 eXpress Plus 
application, use the Application Scheme button at the bottom of the eXpress Plus 
Configuration window (see below). 

Custom Appearance 

Click this button to open the Custom Terminal Screen Appearance  window and configure an 
appearance scheme that may be applied to one or more screens. 

Macro Manager 

Use this selection to open the Macro Manager dialog.  Use the Macro Manager along with the 
Macro Recorder on a screen to create and maintain macros. 

Select Custom Keyboard Layout 

From this list, select a previously configured (see Custom Keyboards, below) keyboard layout 
to be assigned to this screen. 

Custom Keyboards 

Click this button to open the Custom Keyboard Layouts window and configure a keyboard layout 
that may be assigned to one or more screens. 

Application Scheme 

Click this button to change the appearance of eXpress application (see Application Color Scheme 
Preferences).  Note: This will not affect the screen appearance.  The screen appearance can be altered 
by clicking the Custom Appearance button on the Appearance and Keyboard tab (see, above). 
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Restriction Settings/Configure Settings 

Click this button to toggle to and from the restriction settings dialog. 

Restriction Settings dialog 

The restriction settings dialog on the T27 eXpress IT Configuration window contains configuration 
controls that may be used to enforce configuration security by assigning a configuration password. 

Once the password is assigned, all or selected configuration options may be disabled by checking the 
appropriate option.  Subsequently, to enable an option, you must first unlock the configuration by 
providing the assigned password. 

 

  

Use Configuration Lock Options 

Check this box to initiate password protection on configuration options.  Checking this box will cause 
the Lock Config. Initial Password dialog to be displayed.  After entering and confirming the new 
password, additional security features will become visible (see below). 

Note: For the configuration lock to take effect, both the configuration and the emulator must be exited 
and restarted. 
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With this level of eXpress, users may be restricted to one of three levels: the Power User, the Limited 
User and the Restricted User. 

A Power User may configure all options including connections to the host, thus a Power User has no 
configuration restrictions. 

A Limited User is only limited to configuring non-communications options. 

A Restricted User may be denied any configuration capabilities or limited to only those involving 
application/screen appearance and keyboards. 

eXpress User Capabilities at a Glance 

Allowed Capabilities  
User Level Configure 

Connections 
Terminal 
Settings 

Macro 
Development 

Screen 
Appearance 

Customize 
Keyboards 

Application 
Scheme 

Power User Yes Yes Yes Yes Yes Yes 

Limited User No Yes Yes Yes Yes Yes 

Restricted 
User 

No No No Optional Optional Optional 

Settings Location 

The purpose of this feature is to allow all users of a single machine (Windows system) to use the same 
configuration settings for the T27 eXpress Plus terminal emulator and/or the eXpress Connect host 
connections.  By default, all emulator settings are saved in files for the current user (C:\Documents 
and Settings\<<USER>>\Application Data\KMSystems\T27_EXPRESS_PLUS32_4.0\CONFIGURATION) 
which allows multiple users on the same machine to have their own individual settings.   

In some cases, it may be desirable to have one set of configuration settings used by all users of the 
machine.  One reason for common settings is so that the configuration settings can be done once for all 
users, instead of for each individual user; however, users should NOT be allowed to make configuration 
changes once they are set.  There should only be one allowed to maintain the configuration.  If 
common configuration settings are desired, the emulator settings will be stored in common files 
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(C:\Documents and Settings\All Users\Application 
Data\KMSystems\T27_EXPRESS_PLUS32_4.0\CONFIGURATION) and removed from current user. 

The mechanism for creating common configuration settings in the T27 eXpress Plus terminal emulator 
is accessed from this dialog of the T27 eXpress Plus Configuration window.  The eXpress Connect 
transport settings are accessed from the Edit menu in the eXpress Connect Visual Configuration 
window.  Both the emulator and eXpress Connect transport settings are made common or by users, 
independent of one another.  For example, eXpress Connect transport settings may be made common, 
while emulator settings remain by user. 

The Settings Location feature is only available when Use configuration lock options is checked.  
Again, individual users should NOT be allowed to changes settings when the configuration settings are 
common to all users of the same machine.  

Restricted User Options 

The following options are only available when configuring restricted users.  Power users and limited 
user have these capabilities by default. 

Allow Customized Keyboard(s) 

Check this box to allow the restricted use to develop and use personalized keyboards. 

Allow Customized Appearance Scheme(s) 

Check this box to allow the restricted user to develop and assign appearance schemes to 
screens. 

Allow Customize Application Scheme(s) 

Check this box to allow the restricted user to develop and maintain appearance schemes for the 
eXpress Plus application. 
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Unlock Configuration 

This button may be used to display the Unlock Config Password dialog where the proper password 
may be entered to enable the controls on the restrictions dialog.  This button is only visible if the Use 
Configuration Lock Options check box has been set and a password entered. 

Apply 

Click this button to apply the settings immediately without exiting the configuration window.  If you 
have entered the configuration window from the emulator, you will see any changes take effect in the 
emulator immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

eXpress Custom Terminal Screen Appearance 

The eXpress Custom Terminal Screen Appearance window contains configuration controls to 
change screen fonts and to apply colors to specific areas of the display. 
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Appearance Scheme Name 

From this drop-down list box, select the Color Scheme Name to be altered.  Initially, one color 
scheme, Default, is delivered with T27 eXpress IT.  From the Default color scheme, others may be 
created using the Save As button. 

New Scheme 

Use this button to create a new appearance scheme based on the UTS eXpress IT defaults.  By this 
means, each screen can have its own appearance scheme or screens may share an appearance 
scheme.  To attach an appearance scheme to a screen, see T27 eXpress IT Configuration. 

Note:  The scheme named "Default" may be changed but cannot be deleted.  When a new scheme is 
created or an existing scheme Set to Default (see below), the default values are acquired from 
constants internal to T27 eXpress IT, not from the "Default" scheme mentioned here. 

Rename Scheme 

Click this button to rename an existing appearance scheme. 
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Delete Scheme 

Click this button to remove the selected appearance scheme.  Caution:  Any screen attached to the 
deleted scheme will revert to the T27 eXpress IT default scheme. 

Screen Color Settings 

The Screen Color Settings group contains controls that may be used to change the foreground and 
background color of various T27 screen attributes. 

Select Attribute 

From this group, select an attribute option button whose color is to be changed.  When an 
attribute’s colors are changed, those colors will be applied to all areas of the screen having that 
specific attribute.  An attribute’s colors consist of a foreground (text) color and a background 
color. 

Note: The Highlighting button, used in conjunction with the Highlighting Combinations 
options, offers a possibility of 16 color pairs (foreground/background) when selecting colors for 
highlighting attributes (Underline, Bright, Blinking and Reverse Video), a combination of those 
attributes or no attributes. 

Highlighting Combinations 

This group of checkboxes becomes visible only when the Highlighting button is selected.  Each 
checkbox represents a highlighting attribute.  After selecting an attribute, combination of 
attributes or no attribute, use the Choose Foreground (text) Color and Choose 
Background Color controls to set the colors for that selection. 

On the following screen, there are three examples of highlighting:  Highlighting-None (white on 
teal), Highlighting-Underline (white on blue) and Highlighting-Bright (yellow on teal). 
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Configuration for Highlighting-Bright: 

  

Choose Foreground (text) Color 

To change the text color of an attribute, first select the attribute from the Select Color for 
Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish 
to use one of the standard Windows colors, select Custom at the bottom of the list and 
configure the desired color with the standard Windows Color dialog. 

Choose Background Color 

To change the background color of an attribute, first select the attribute from the Select Color 
for Attribute option group.  Next, select a color from this drop-down list box.  If you do not 
wish to use one of the standard Windows colors, select Custom at the bottom of the list and 
configure the desired color with the standard Windows Color dialog. 

Screen Font 

Use the controls in this group to change the screen font, intensity, size and character set. 

Font Name 

From this drop-down list box, choose the desired font. 



KMSYS Worldwide, Inc. T27 eXpress IT 

12/01/2005 21 

Bold 

Click this button toggle to increase or decrease the intensity of the selected font. 

Font Size 

Use this spin box to increase or decrease the size of the selected font. 

Character Set 

Use this drop-down list box to change the character set. 

Automatic Font Scaling 

These three options control how the emulator will behave when you size a station window or change 
the screen font. 

None 

When the None option is set, no screen or font scaling will be performed when the screen 
window is resized. 

Screen to Font 

The Screen to Font option causes the screen window size to be changed automatically when 
the screen font size is changed.  Consequently, the station window size may be changed 
without altering the size of the font.  If the size of the window is made larger than that 
necessary to accommodate the screen size, a blank area will show the physical limits of the 
screen. If the window size is reduced below the physical screen size, scroll bars appear allowing 
access to those parts of the screen not currently visible.   

Font to Screen 

The Font to Screen option causes the font size to change automatically whenever the window 
size of the station is altered.  For example: If a window is enlarged or made smaller, the font 
will increase or decrease in size, accordingly.  The Font to Screen option will only work when 
using a scalable font (e.g., Courier New, Lucida Sans Typewriter, etc.).  To select a scalable 
font, click on the Screen Font button. 

Default 

Use this button to change the selected color scheme to the T27 eXpress IT defaults. 

Import 

Click this button to import an existing appearance settings file. 

Export 

Click this button to export the appearance settings to a file. 

Apply 

Apply the settings immediately without exiting the configuration window.  If you have entered the 
configuration window from the emulator, you will see any changes take effect in the emulator 
immediately. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

Help 

Receive on help for this window. 

eXpress Custom Keyboard Layout 

This window is used to define which Windows keyboard key, or key combination, will be used to initiate 
a T27 terminal or T27 eXpress IT emulation specific action.  Use this window to customize the keyboard 
to meet your specific needs. 
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New Keyboard 

Click this button to name a new keyboard layout. 

Rename Keyboard 

Click this button to rename an existing keyboard layout. 

Delete Keyboard 

Click this button to delete the selected keyboard layout. 

Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations associated with a 
terminal key.  Note: The location and arrangement of the keys on the graphic keyboard may not match 
the exact layout of your keyboard; however, most keys on your keyboard should have its 
corresponding key represented on the graphic keyboard.  After selecting a key name from the Key 
Actions and Key Sequence Assignment list, the configured key or key combinations will appear as if 
they have been pressed.  You may change (redefine) or add additional key combinations by pressing 
the key(s) on the graphic keyboard with a left mouse click.  Valid key combinations are any single key, 
or a single key plus a combination of one or more of the optional, Shift, Alt and Ctrl keys.  When the 
desired key combinations have been selected, press the Set Key Assignment button to assign the 
key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to 
change accordingly. 

The extended keys (see below) are not mapped to any key in the Key Actions  list for the default 
keyboard layout file.  They may, however, be mapped by the user to any key or script in the Key 
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Actions  list.  If they are not mapped, their behavior will be the same as their counterparts on the 
numeric keypad and main keyboard. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

Key Actions 

This list box contains the names of all keys used to control T27 terminal activities or activities specific 
to T27 eXpress IT terminal emulation.  These keys can be mapped to keys pressed on the graphic 
keyboard or via the Type a Key Sequence button. 

Type a Key Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type 
the key sequence you desire to map to the currently selected name in the Key Actions list.  On your 
acceptance of the typed key sequence, the key will automatically be mapped. 

Set Key Assignment 

This button sets the mapping of the currently selected Key Action to the selected graphic keyboard 
keys. 

Undefine Key 

This button is used to remove the mapping of a key.  You may remove a mapped key by first selecting 
the key in the Key Actions list followed by a click of this button. 

Default 

This button loads the default keyboard layout as distributed by KMSYS Worldwide, Inc. 

Import 

Use this button to import an existing keyboard definition file (.KEY). 

Export 

Use this button to save the current keyboard layout to a file. 

Print 

Click this button to print a list of all key actions and key action assignments.  Note: The list will include 
any key sequences assigned to scripts. 

OK 

Clicking the OK button saves all changes made in this window and closes the window. 

Cancel 

Clicking the Cancel button closes this window and discards all changes made since it was last opened. 

Help 

Receive on help for this window. 

How to Map or Re-Map a T27 Terminal or a T27 eXpress IT Key 

The following describes the procedure for re-mapping T27 terminal or T27 eXpress IT keys: 

1) Select the key to be re-mapped from the Key Actions list box. 
2) There are two methods of defining which key or key combination to map to the selected name in the 

Terminal Keyboard Key Names list: 
a) Click the Type Key Sequence button, then type the desired key sequence directly on 

your keyboard.  When you accept the key sequence, the key mapping will automatically 
be set. 
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b) Select the desired key from the graphic keyboard using a left mouse click over the face of 
the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them with the 
mouse.  Finally, to set the keys selected, click the Set Key Assignment button. 

These steps may be repeated until all desired key mappings are completed. 

Conflicts 

If a selected key sequence is already mapped to another key, a message box will appear naming the 
mapped Key Actions.  You may then re-map or "undefine" the Key Actions in conflict or choose a 
different key sequence. 

If you map a Key Actions that already has a key sequence assigned to it, a window will appear 
allowing you to Add an alternate key sequence, Redefine (replace) the existing key sequence with the 
new key sequence or Cancel the key assignment operation altogether. 

Add or Redefine Key 

The Add or Redefine Key window appears when a conflict is discovered while attempting to assign a 
keystroke or keystroke combination to a keyboard function. 

Help 

Click this button to receive on help for this window. 

Add 

Click this button to add an alternate key sequence.  This choice is useful when you want more than one 
keyboard key to perform the same function (e.g., the two Enter keys). 

Redefine 

Redefine or replace the existing key sequence. 

Cancel 

Clicking the Cancel button closes this window without assigning the key. 

eXpress IT Macro Manager 

This tab is used to maintain key macros.  Key macros may consist of any T27 key function, standard 
Windows cut/copy/paste, text strings, text strings with user prompts, timed waits and conditional waits 
for strings.  Macros may be created initially within the macro editor or through the use of the macro 
recorder from any open screen. 
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Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations assigned to activate a 
macro.  Note: The location and arrangement of the keys on the graphic keyboard may not match the 
exact layout of your keyboard; however, most keys on your keyboard should have its corresponding 
key represented on the graphic keyboard.  After selecting a macro name from the Available Macros 
list, the configured key or key combinations will appear as if they have been pressed (light gray).  You 
may change (redefine) or add additional key combinations by pressing the key(s) on the graphic 
keyboard with a left mouse click.  Valid key combinations are any single key plus one or more of the 
optional, Shift, Alt and Ctrl keys.  When the desired key combinations have been selected, press the 
Set Assignment button to assign the key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to 
change accordingly. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

The extended keys may be mapped to any macro in the Available Macros list.  If they are not 
mapped, their behavior will be the same as their counterparts on the numeric keypad and main 
keyboard. 

Available Macros 

This list box contains the names of all configured key macros.  Each macro can have an activation 
key(s) assigned by pressing the keys on the graphic keyboard, followed by the Set Assignment 
button, or via the Type Sequence button. 
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New Macro 

Click this button to create a new macro.  Hint: You can easily create a new macro by using the macro 
recorder on the T27 eXpress IT emulator window.  See the Start Recorder selection on the Macros 
menu. 

Edit Macro 

After selecting a macro from the Available Macros list, click this button to edit or view the macro with 
the Edit Macro dialog. 

Delete Macro 

After selecting a macro from the Available Macros list, click this button to delete the macro. 

Show in Menu 

Use this button to toggle between placing the selected macro on the Macros menu and removing it 
from view. 

Type Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type 
the key sequence you desire to map to the currently selected name in the Available Macros list.  On 
your acceptance of the typed key sequence, the key will automatically be mapped. 

Set Assignment 

This button sets the mapping of the currently selected Available Macros to the selected graphic 
keyboard keys. 

Clear Assignment 

This button is used to remove a key mapping.  You may remove a mapped key by first selecting the 
key in the Available Macros list followed by a click of this button. 

How to Assign a Macro Activation Key 

The following describes the procedure for assigning macro activation keys: 

1) Select the key to be remapped from the Available Macros list box. 
2) There are two methods of defining which key or key combination to map to the selected name in the 

Available Macros list: 
a) Click the Type Sequence button, then type the desired key sequence directly on your 

keyboard.  When you accept the key sequence, the key mapping will automatically be 
set. 

b) Select the desired key from the graphic keyboard using a left mouse click over the face of 
the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them with the 
mouse.  Finally, to set the keys selected, click the Set Assignment button. 

These steps may be repeated until all desired activation keys have been assigned. 

Conflicts 

If a selected key sequence is already mapped to another key (macro activation key or terminal 
function), a message box will appear naming the mapped macro or terminal function.  You may then 
re-map or remove the Available Macros in conflict or choose a different key sequence. 

Edit Macro 

The Edit Macro window is used to create and edit a string of successive keystrokes, waits and 
conditions that can comprise a macro. 
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Key Macro Name 

In this text box, enter the name of the macro as it will appear on the Macros menu or macro bar. 

Macro Function List 

This list box contains a serial list of keystrokes, timed waits, prompts and wait conditions that can be 
included in a key macro.  Select from this list when replacing, deleting or moving a function in the list. 

Add 

Click this button to reveal a drop-down menu containing six different types of functions that may be 
included in the macro. 

Terminal Key Function 

Make this selection to bring up the Select Terminal Key Function window where a single T27 or 
T27 eXpress IT terminal keystroke (e.g., SOE, XMIT, CLIPBOARD_COPY, etc.) may be selected. 

Text String 

Make this selection to initiate the Text String dialog used to enter a string of text in the macro. 

Text String Prompt 

Use this selection to place a user prompt dialog in the macro.  The selection displays the Edit 
Prompt for Text window where a user prompt string may be entered.  When the macro is run, 
the dialog will be displayed with the user prompt, querying the user to enter a text string.  

Cursor Position 

Use this selection to place the cursor at a particular row and column.  This selection displays the 
Position Cursor dialog where the row and column may be entered. 
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Timed Wait 

Make this selection to specify that the macro should wait for a period.  The selection displays 
the Timed Wait window where the pause time is specified in seconds. 

Wait for String 

Select this item to insert a conditional wait in the macro.  The ensuing Wait for String dialog 
allows you to specify a search string, the location of the search string on the screen, an equal or 
not equal operator and a timed wait value. 

Replace 

After selecting a function from the Macro Function List box, click this button to replace the function 
with a different function, or edit the selected function.  This button drops down the same selection 
menu as described for the Add button (see above). 

Delete 

After selecting a function from the Macro Function List box, click this button to delete the function 
from the macro. 

Move Up 

Press this button to move the selected function up in the macro. 

Move Down 

Press this button to move the selected function down in the macro. 

Revert 

Clicking this button will revert any changes to the macro since the dialog was opened.. 

OK 

Click this button to accept the changes to the macro and close the window. 

Cancel 

Click this button to discard any changes and close the window. 

Edit Prompt for Text 

This window allows a user prompt to be entered and placed in the macro. 

Enter User Prompt 

In this text box, enter the prompt to be displayed when the user is asked to enter a text string. 

Password Entry 

Check this box to password protect the text entered by the user.  Password protection causes asterisks 
(*) to be displayed in the text box as the user enters the text string. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Position Cursor 

This window allows you to position the cursor to a location on the screen. 

Column 

In this text box, enter the column to place the cursor. 
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Row 

In this text box, enter the row to place the cursor. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Select Terminal Key Function 

This window allows the entry of single T27 terminal key or T27 eXpress IT key functions into the script. 

Type List Search String 

In this text box, enter a partial or full terminal key function name.  Type only enough of the name to 
highlight the desired key function in the key function list box below this list box. 

OK 

Click this button to select the highlighted key function. 

Cancel 

Click this button to cancel the selection process. 

Text String 

This window allows the macro developer to enter a string of text in the macro. 

Enter a Text String 

In this text box enter the text string.  The string of text will be inserted at the current cursor position 
on the screen. 

OK 

Click this button to accept the text entry and close the window. 

Cancel 

Click this button to discard the entry and close the window. 

Timed Wait 

This window allows the entry of a pause in the execution of the macro.  The timed wait is useful when 
communications is slow and a large amount of processing from the host occurs before returning control 
to the terminal screen. 

Enter Wait Time in Seconds 

In this text box, enter the number of seconds the macro is to wait before resuming processing of the 
next macro function. 

OK 

Click this button to accept the entry and close the window. 

Cancel 

Click this button to discard the entry and close the window. 

Wait for String 

This window allows a conditional wait to be placed in the macro.  The macro will wait for the presence 
or absence of a string returned from the host. 
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String Value 

In this text box, enter the string to look for on the screen.  The value entered is case insensitive. 

String Location 

This group allows the location on the screen of the anticipated text string. 

When choosing the location on the screen to test for a string, you should be aware of the sequence of 
events that occurs, before the macro gets control to do the testing.  For example, in DEMAND mode, 
most output received from the host is painted on the next to last line of the terminal display.  Before 
control is returned to the macro, a CURSOR TO HOME and DELETE LINE is issued, thus moving the 
output to two lines from the bottom of the display.  Thus, on a 24-line display, testing should be 
performed on row 22, not row 23. 

Row 

In this text box, specify the row where the beginning of the string is expected. 

Relative to Current Row 

If this box is checked, the value entered in the Row text box is relative to the current row of 
the cursor. 

Column 

In this text box, specify the column where the beginning of the string is expected. 

Relative to Current Column 

If this box is checked, the value entered in the Column text box is relative to the current 
column of the cursor. 

Any position in Entire Screen 

Check this box to look for the string beginning at any position on the screen. 

Wait for String To Be 

This option group is used to specify if the condition checked for is true or false. 

Equal = 

Select this option to check for an equal condition. 

Not Equal <> 

Select this option to check for a not equal condition. 

Wait Time (seconds) 

In this text box, enter the number of seconds to wait before failing the test.  In other words, this is the 
interval of time to wait for the presence (=) or absence (<>) of the anticipated string.  When this time 
is exceeded, a time-out message box will appear during macro execution. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

 

T27 Character Translation Configuration 

The T27 Character Translation Configuration window provides the ability to select and edit 
character translation sets for specific countries. 
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Select the translation set (the default is NO TRANSLATION) for your locality. 

To add a translation set, click the Add button.  A second window will appear where you may enter a 
country name that will correspond to the translation set. 

To change one or more characters in a translation set, highlight a country name using the left mouse 
button or the up/down arrow keys and click the Edit button. 

To delete a translation set, highlight a country name using the left mouse button or the up/down arrow 
keys and click the Delete button. 

Character Translation Edit 

This window allows you to specify host character and local character pairs for translation on all data 
received from, or sent to, the host during a T27 eXpress IT session.  All characters are specified in 
ASCII numeric notation. 
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Select an existing character in the translation table using the scroll bar, mouse and/or up/down arrow 
keys.  Type any changes into the two text boxes (Host and Local) at the bottom of the window. 

To add a new character, select each of the two text boxes (Host and Local) at the bottom of the 
window, enter the new values and click the Add button. 

To delete an existing character, select a character in the translation table using the scroll bar, mouse 
and/or up/down arrow keys and click the Delete button. 

Application Color Scheme Preferences 

The Application Color Scheme Preferences window contains controls that affect the appearance of 
the eXpress application.   

Selection on this window does not affect the appearance of the screen portion of an opened session.  
Unlike color selections set for emulation screens, application colors will be affected by any changes that 
have been made to the Windows System Colors. 
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Schemes 

From the drop-down list box, select from one of the pre-configured schemes from KMSYS Worldwide or 
from a scheme created by you.  The pre-configured schemes marked as, "(Preset)", may not be altered 
but may be selected and become the basis of a new scheme created by you (see the New Scheme 
button. 

New Scheme 

Click this button to create (name) a new application scheme.  Note: Whatever scheme is 
selected from the drop-down list box will be the basis of the new scheme. 

Rename Scheme 

Click this button to rename a selected scheme.  "(Preset)" schemes may not be renamed. 

Delete Scheme 

Click this button to delete a selected scheme.  "(Preset)" schemes may not be deleted. 

Button Effects 

The controls in this group determine the appearance of buttons on the eXpress application. 

Select Button Color Effects 

Use the buttons in this group in conjunction with the Select Color button to change the colors 
of buttons and the colors displayed on mouse flyover. 

Normal Background 

Click this button followed by the Select Color button to change the background color 
of non-selected buttons. 
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Normal Text 

Click this button followed by the Select Color button to change the color of text on 
non-selected buttons. 

Normal Border 

Click this button followed by the Select Color button to change the color of the border 
surrounding non-selected buttons. 

Flyover Background 

Click this button followed by the Select Color button to change the background color 
of buttons when the mouse cursor is moved over the button. 

Flyover Text 

Click this button followed by the Select Color button to change the text color that will 
appear when the mouse cursor is moved over a button. 

Flyover Border 

Click this button followed by the Select Color button to change the border color that 
will appear when the mouse cursor is moved over a button. 

Selected Background 

Click this button followed by the Select Color button to change background color of a 
selected button. 

Selected Text 

Click this button followed by the Select Color button to change the text color of a 
selected button. 

Selected Border 

Click this button followed by the Select Color button to change the border color of a 
selected button. 

Flyover Sel Background 

Click this button followed by the Select Color button to change the background color 
of a selected button when the mouse cursor is moved over the button. 

Flyover Sel Text 

Click this button followed by the Select Color button to change the text color of a 
selected button when the mouse cursor is moved over the button 

Flyover Sel Border 

Click this button followed by the Select Color button to change the border color of a 
selected button when the mouse cursor is moved over the button 

Select Color 

Use this button to change color after selecting a button effect from the Select Button Color 
Effects button group. 

Use Standard Windows Look 

Standard look will make buttons and panel look like the standard windows controls.  If XP 
themes are in uses, buttons will have themes applied.   

Note: When this box is checked, changes made using other color controls on this dialog will not 
be evident in the eXpress application; i.e., checking this box overrides all other color selections 
for the application.  Screen color selections are unaffected by this option. 

Use 3d Button Effect 

If this box is checked, all buttons will have a three-dimensional appearance.  If the box is not 
checked, buttons will have a flat appearance. 

Form Color Preview 

All controls in this group are for preview purposes only. 
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Panel Title Text 

The background and text in this title are affected by selections made with the Panel Title 
Color and Panel Title Text Color buttons in the Window Effects group at the bottom of this 
dialog. 

Sample Button 

The appearance of this button can be altered by any of the controls in the Button 
Effects group to the left of this preview panel. 

Sample Selected 

When this box is checked, the Sample Button will appear as determined by the 
bottom six buttons in the Select Button Color Effects; unchecked, the top six 
determine the effect. 

Panel Text 

Panel text and panel background are set using the Panel Text Color and Panel Color 
buttons, respectively. 

Window Effects 

The six buttons in this group let you set the color scheme for the windows, panels and text displayed in 
the eXpress application.  For button colors, see above. 

Window Color 

This button determines the background color of the eXpress windows. 

Window Text Color 

This button determines the color of any text appearing on an eXpress window.  It does not 
affect panel or button text. 

Panel Color 

Use this button to alter the background color of a panel. 

Panel Text Color 

Use this button to change any text found on a panel. 

Panel Title Color 

This button may be used to alter the background color of panel titles. 

Panel Title Text Color 

Use this button to alter the text color of panel titles. 

Set to Defaults 

This button may be used to reset button and window color defaults according to the way they are 
defined in Windows. 

Apply 

Use this button to apply any changes immediately without exiting this window. 

OK 

Use this button to accept changes and exit the window. 

Cancel 

Use this button to reject any changes and exit the window. 

 

Application Color Selector 

The color selections on this window are divided into three groups: A basic 40-color set, the standard 
Windows 27 System Colors and a custom color area for gradient color selection.  There is also a list box 
of System Colors by Name for selection. 

Note: System Colors changed from the Windows Control Panel will affect the System Colors made 
available on this window. 
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Std. Color Dialog 

Click this button to use the traditional Color dialog for selection. 

Apply 

Click this button to apply any changes without exiting the selection dialog. 

OK 

Click this button to accept any changes and exit the window. 

Cancel 

Click this button to discard any changes and exit the window. 

 

Lock Config. Initial Password window 

This dialog is used to supply an initial password that will be required to access the configuration 
controls.   

New Password 

Enter a 1-8-character password.  All keyboard characters are allowed. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 

Cancel 

Press this button to cancel any entries made on this dialog. 



KMSYS Worldwide, Inc. T27 eXpress IT 

12/01/2005 37 

Unlock Config. Password window 

This dialog is used to supply the password that will enable the configuration controls.  The dialog may 
also be used to change an existing password. 

Enter Password 

Enter the password required to unlock (enable) the configuration controls. 

New Password 

To change the password, enter the new password in this box.  This entry is optional. 

Reenter New Password to Confirm 

Reenter the same password in order to confirm the entry.  This entry is required when the New 
Password entry is specified. 

OK 

Press this button to accept the entries on this dialog and continue. 

Cancel 

Press this button to cancel any entries made on this dialog. 

T27 eXpress IT Settings 

This dialog is used to switch the location of the T27 eXpress IT configuration settings.  The settings 
may be stored in such a manner as to allow multiple users of a single Windows system to maintain 
their individual configurations.  When individual configurations are to be maintained (the default), the 
settings are placed under C:\Documents and Settings\<This User>\Application Data.  On the other 
hand, if it is desirable for all users of the system to use the same configuration, an option is available 
to move those settings to the common location, C:\Documents and Settings\All Users\Application Data. 

Note: "<This User>" will be the user-id used to log on to Windows. 

 

  

  
The dialog acts as a toggle between <This User> and All Users; i.e., if your settings are currently 
stored in <This User>, the message will indicate that they be moved to All Users; if they are in All 
Users, the move would be to <This User>. 
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Delete Source Settings 

Check this box to delete the settings in their former location.  If this box is not checked, the settings 
will remain in their old location but will NOT be used or updated in any way. 

Set 

After selecting an option above, click this button to complete the move. 

Cancel 

Press this button to ignore any selections and return to the previous dialog. 
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How to ... 

Selecting with the Mouse 

All selections discussed in this section are made with a single click of the left mouse button.  For 
example the instruction, "select Print Screen from the File menu," implies that the following actions 
should be taken: 

1. Move the mouse cursor over the word, File, on the menu bar. 

2. Click the left mouse button once to reveal the menu. 

3. Move the mouse cursor over the Print Screen selection. 

4. Press the left mouse button again to complete the instruction. 

Note: Left and right, mouse button actions may be reversed (run the Mouse icon/program in the 
Windows Control Panel). 

Many of the menu selections also have corresponding buttons.  These buttons are conveniently located 
on a toolbar immediately below the menu bar.  These buttons represent the more frequently executed 
T27 eXpress IT commands or selections. 

Where appropriate, shortcut keys are shown in parentheses and toolbar buttons are shown in the right 
margin of the discussions below. 

Running without the Control Panel 

You may run T27 eXpress IT without the control panel being visible using the NCP command line option 
as follows: 

"c:\Program Files\KMSystems\ T27eXpressIT \3.0\ T27eXpressIT.exe" NCP 

To run with the NCP option, you must first run without it and configure at least one environment to 
automatically open at start-up.  To configure: 

1. Start T27 eXpress IT without the NCP option. 

2. Click the Configure T27 eXpress IT button  on the control panel. 

3. Select and configure an environment as desired. 

4. Check the Open Environment on Start-up 

5. Repeat Steps 3 and 4 if additional environments are required. 

6. Click the OK button. 

7. Click the Exit button  on the control panel. 

Finally, add the NCP command line option to the Target entry of the T27 eXpress IT shortcut as 
follows: 

1. Right click on the T27 eXpress Plus icon.  From the Windows Task Bar, this icon is on the 
Start | Programs | T27 eXpress Plus menu.  

2. Select Properties. 

3. Change the Target entry. 

Note: When all environments are closed by the user, T27 eXpress IT will automatically exit. 

Configuring T27 Keys 

To change a T27 key, follow this procedure: 

1. Click the Configure button  on the T27 eXpress IT Control Panel.  

2. After selecting a screen tab, press the Custom Keyboards button 

 on the Other Settings tab.  The eXpress Custom 
Keyboard Layouts window will appear. 

3. Select the keyboard layout you wish to configure from the Keyboard Name drop-down list 
box, or a new layout using the New Keyboard button to the right.  Note: Layouts are 
related via a named keyboard and associated with a particular screen on the Other 
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Settings tab.  In this manner, it is possible for each configured screen to have its own 
unique keyboard layout or share a layout with other screens. 

4. Select a key from the list box under Terminal Keys. 

5. Press the desired key or key combination (any key plus Alt, Ctrl and/or Shift) on the 
visual keyboard. 

6. Press the Set key assignment button. 

7. If a key is already defined, a message window will appear allowing you to replace 
(Redefine) the existing definition or Add an additional definition.  Also, if a key 
combination is already assigned to another key action, you will get an error.  In that case 
you will need to "Undefine" that other key action first. 

8. Press the OK button on the eXpress Custom Keyboard Layouts window. 

9. Back on the Other Settings tab, select your keyboard from the Select Custom Keyboard 
Layout drop-down list box.  Note: You may have to exit the Configuration window and re-
enter to see the name of your keyboard in the list box. 

10. Repeat steps 2 through 8 for each screen desired. 

11. Press the OK button on the T27 eXpress IT Configuration window. 

Recall Recent Input 

On occasion, you may wish recall or retransmit a line of input to the host, and that line no longer 
appears on the screen.  T27 eXpress IT retains a list of the 200 most recent lines sent to the host when 
not in forms mode.  The following procedure outlines the steps required to use this feature: 

1. Position the cursor at the point on the screen where you wish the line to be repainted. 

2. Press Ctrl+Up Arrow (this key is configurable, see Configuring T27 Keys) or select Input 
Recall from the Edit window. 

3. With the mouse, select the desired line from the list box provided. 

4. Click the Transmit button to paint the line and transmit it to the host (double-clicking the 
line will also cause a transmit).  If you wish to alter the line before transmitting, click on 
the Paste button. 

Note:  This feature is particularly useful when the recall line is lengthy and you wish to avoid having to 
retype the entire line. 

Displaying T27 eXpress IT Keyboard Definitions 

At times, you may wish to perform standard T27 terminal functions through the keyboard such as Clear 
Home, Delete Character Page, etc.  An easy way to see the keyboard key sequences required to 
perform these T27 terminal functions is through the display of the Keyboard Help window.  To view 
this window, select Show Keyboard Help Window from the View menu. 

Execute any key (T27 key or Keyboard Key Sequence) in the window’s list box by double clicking on 
it, or leave the window displayed as a reference to key sequences required from the keyboard.   

With the Keyboard Help window displayed, you may reposition the cursor with two left mouse clicks 
anywhere in a T27 eXpress IT screen. 

To keep the Keyboard Help window completely visible while working on a T27 eXpress IT screen, 
check the Stay on top box. 
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Miscellaneous 

Command Line Options 

The following are the T27 command line options.  They are NOT case sensitive and are separated by 
spaces: 

NL  = No Logo (Splash Screen) 

NCP = No Control Panel 

SMAX = Show Screens Maximized 

TRANSTRACE = Transport Trace On Start   

MULTI_INST = Allow multiple instances of program 

Font Limitations 

The ability to increase/decrease font size by a single point only works properly when using scalable 
fonts like the True Type font, Courier New (installed with Windows).  Non-scalable fonts have a fixed 
number of point sizes available (e.g., 6, 9, 11, 14, etc.) and are missing several point sizes (e.g., 7, 8, 
10, 12, 13).  Consequently, T27 eXpress IT will be unable to increment or decrement to the missing 
sizes.  To select a different font, follow this procedure: 

1. Click on the Configure T27 eXpress IT Options button  on the T27 eXpress IT 
Control Panel.  

2. Select the desired screen. 

3. Select the Other Settings tab. 

4. Click the Custom Appearance button. 

5. Click the Screen Font button. 

6. Select the desired font and font style. 

7. Press the OK button. 

Note: All of the True Type fonts are scalable. 

Technical Support 

If you are experiencing difficulties configuring T27 eXpress IT and need assistance, please contact the 
person responsible for maintaining T27 eXpress IT at your site.  If you are having trouble connecting to 
a host mainframe, please consult the person(s) responsible for maintaining communications at your 
site.  If difficulties persist, you may reach the Technical Support Group at KMSYS Worldwide, Inc., 
through one of the following: 

Internet E-mail Support – support@kmsys.com 
Telephone Support – (770) 635-6363  

Web Site – www.kmsys.com 
Main Number – (770) 635-6350 

Facsimile – (770) 635-6351 

 

mailto:support@kmsys.com
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